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1)

Open a loan from Pipeline view.

hitps://BE274350.e2.elliemae.netSBE274350 - kduclo

Encompass View Loan Forms Verifs Tools Services Help

Home  Pipeine  Loan

2) From Services tab, select

Mortgage Insurance.

{2} 8325 Six Forks Road
3) Select Enact > Submit. '

[ Aerts & Messages

N AUS Deta Discrepancy

Log [3
B LTV change -- Ensure | 01725722
0524122

Trades  Contacts  Dashboard  Reports

| Borrowers | Ly andLanis Lizard

My Providers  All Providers

Select a provider and click Submit.

4) Verify your Master Policy B
Number is accurate
“B22222
5) Inthe Request Type dropdown,
select Non-Delegated MI. Enter Foms  Toos | serees
. . . » Order Appraisal ~
a Rate Quote ID if associating to 5 cisseriood Cortieaton
a previous quote. S —
» Register MERS Remove from My List ‘Submit Cancel
6) Select the appropriate AUS + Order AV — =
Finding for Fannie Mae or T | —— , v
Fredd|e MaC [ Show in Alpha Order < _ > J
. | B 5 | o5r28 0802 | uesday, 51242022
7) Select Special Features as
applicable. Enact Request X
8) Select the Order button. +nact
. . an Informati
9) Upon a successful submission, e T Lf:::: = b, i
. . Processor ID ___ENOOMPASS wer:  Lanisa
the following prompt will be o Loan Number:
. & Save Login knfomation ( %) Required field
displayed. Select OK to open the o o
Upload Documents feature. Reauest Type: | Non-Deegated Ml 2
FeteGute 1D 5
Mortgage Insurance Information Mortgage Insurance Payment Option
MiI Cettificate Type | Primary v %
MiCoverage™ [35 | @ & MiPremium Payment Plan [BorowerPaid v| %
New Order X P opton | Ze0Montly  v| #  PemunRatePanTipe |Love S .
Refund Type | NotRefundable v| ®  Spit Premium Plan Type >
Denewels Constant ~| * [0 Premium Financed )
Thank you for your submission! Please click OK to begin Credt Risk Class: | v orkract Undenalirg e
uploading your loan documentation. Your request will remain Purchase Bligbity | ﬂ v Service Request B .
in a suspended status until loan documents have been Recommendation: | ApproveEligble > e Nare N
reviewed by a Genworth underwriter. = R
Loan Information Origination Information
SpecalProgem [ | Non-Retail Origination
Special Features - (select all that apply) Origination Channel Retail
S,F.hm — %::mm TPO Company Name
0 Rebcston Lsan [mavnee
TPO State

| Community Home BuyerPr{
Vist enacim com forful packagiomepecate
Other

| Submit

If you receive an error, contact the Enact ActionCenter® at 800-444-5664 for further assistance, or

correct your loan data and resubmit.

Enact mortgage insurers include Enact Mortgage Insurance Corporation

and Enact Mortgage Insurance Corporation of North Carolina.
© 2022 Enact Holdings, Inc. All rights reserved.
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1) To upload documents, select the Enactfequen
View tab (if not active) on the - -
Enact Request screen. -hn aCt
Loan Information
2) Select the Upload Documents Ma"mgw ., =
button to view the Attachment Pomncnd Loan Number:  GNWPPM2213785
List. [ save Login Infomation LS eaiedied
Orter
3) Select the plus (+) sign to add
. Order No. Order Date Product Name Status
documents to the list. 3808113081 07062022 04:3923PM  Non-Delegated MI Suspended
4) Choose the location from which .
you'd like to retrieve your _WW - Frscnmentis
documents. Dae | Documert ' %
Comments (Optional) Attachment Path
a) Browse from the hard drive
on your computer or a local —
drive.
Helpful Hint: , -
(oreck Saun | Vew | [ Cons
Hold down the Citrl key to
select multiple docs at one Attach

time.

OR

b) Browse from the Encompass
eFolder associated with this
file.

5) Select Continue to open the

Select Documents window.

Comments (Optional) |

Select a browse location of the document you wish to attach
to the order:

(O Browse from Hardrive
(® Browse from Encompass eFolder

| Continve | | Cancel

€5 Select Documents

Choose a stacking order to arrange the documents. Click Continue when done selecting the documents.

Stacking Order | None

V| Update Template

‘ Documents
‘ At Name
™ & 1003-URLA

M & Appraisal
|8 Credit Report

Requested From

@ Learn more...

For Borrower Pair Status Date
Larry and Lanisa Lizard Received 07/06/22
Larry and Lanisa Lizard Received 0706122
Larry and Lanisa Lizard Received 0706122
a
Preview l \ Continue | Cancel

6) Selecting Preview will display all documents selected in one PDF document.

7)

Enact mortgage insurers include Enact Mortgage Insurance Corporation

and Enact Mortgage Insurance Corporation of North Carolina.
© 2022 Enact Holdings, Inc. All rights reserved.

If selecting documents from the eFolder, choose the desired documents and select Continue.
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Helpful Hint:

If your admin has set-up a Stacking Order, select it from the dropdown to view all available

documents.

8) Verify the documents you desire Attachment List X
to send are listed in the
Attachment List window and v b
select Send. Comments (Optional) Attachment Path

1003 - URLA C:\Users\430015168\4ppD ata\Local\Temp\Enco

9) After a successful submission, Appraisal C:\Users\430015168\appDatatLocalTemptEnco
you will receive a FiIe(s) ! Credit Report C:\Users\430015168\4ppData\Local\Temp\Enco
uploaded successfully prompt.
Select OK. | Send

Uploaded documents will be Order Update X

displayed in the Document Upload
History list.

a File(s) uploaded successfully

I Upload Documents IRgur_ed' documents {RetrieveByNew(jj

Document Upload History
Date Document Name Comments Status
7/6/2022 1003 - URLA OK
7/6/2022  Appraisal OK
7/6/2022  Credit Report OK

After documents have been submitted
to Underwriting.

1) The loan status will appear as
Suspended until the commitment
is rendered.

2) Once you are notified by Enact
via email that the commitment is
available, you can retrieve that
decision by selecting the Check
Status button.

Enact mortgage insurers include Enact Mortgage Insurance Corporation
and Enact Mortgage Insurance Corporation of North Carolina.
© 2022 Enact Holdings, Inc. All rights reserved.

[See screenshot on next page]
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3) You can upload additional Enact Recuiest %
documents by selecting the _I_- t
Upload Documents button. =Nac
. . Loan Information
4) A success message will display ese Fokcy Bk (0 222225VGF Bormower: Lizad, Lany
once the commitment is returned. | fe==r® S
Password _m :
[ Save Login Information (*) Required field
Order
Order No. Order Date Product Name Status
3808113081 07-06-2022 04:39:23 PM Non-Delegated MI Suspended
Upload Documents | Required documents | Retrieve By New Order No | import
Document Upload History Received Documents
Date Document Name Comments Status Received Date  Document Name
7/6/2022 1003 - URLA 0K
7/6/2022  Appraisal 0K
7/6/2022  Credit Report 0K
|Check Status || View | | Cancel
Order Update X
o The MI Request has been successfully processed
Once the commitment has been e o x
delivered: g -
+nact
5) Select the View tab (if not already | Mester Poicy Nomber [p2222250G7 | e e
selected). Processor D oy S
3 Loan Number: GNWPPM2213785
6) Selectthe Commitment to Emwﬁ“m (%) e e
review. S
) . Order No. Order Date Product Name Status
7) Select the View button to view a 3808113081 07-06:202204:39:23PM  Non-Delegated MI o
PDF of the Ml Commitment.
| Upload Documents | Required documents | Retrieve By New OrderNo | [ mpot |
Document Upload History Received Documents
Date Document Name Comments Status Received Date  Document Name
7/6/2022 1003 - URLA OK 07-20-20220... EnactM|.CommitmentCertificate
7/6/2022  Appraisal OK
7/6/2022  Credit Report 0K
[Check Status || View | | Cancel

Enact mortgage insurers include Enact Mortgage Insurance Corporation

4
and Enact Mortgage Insurance Corporation of North Carolina. ®
© 2022 Enact Holdings, Inc. All rights reserved. n a C
4



The MI Commitment will open in the PDF viewer.

|#] GENWORTH.PDF - Adobe Acrobat Reader DC (32-bit) — m} X
~ Q
ENACT MORTGAGE INSURANCE CORPORATION ("COMPANY™) d *
_ +nact
- e Commitment/Certificate N 3808113081 (=
e Lender Loan Number: GNWPPM2213785
Action.Center@EnactMIl.com Pl b
COMMITMENT/CERTIFICATE OF INSURANCE ﬁ'
Enact tgage | C ion hereby issues this C: i if of (C/C) for the loan herein described, subject to: (1) the terms and
conditions of the Policy and (2) any conditions to the extent set forth below; and in rek. upon the A i pporting ials, and other i i ’
ided in ion with this tg: i i [ e coverag wi!beg’naof&nCerﬁﬁcaeEﬂeeﬁveDamscbjeqmpammde o

as required in the Policy and as provided for in the mortgage i

Initial Insured or Servicer Information

Initial Insured or Servicer Name ~ THIS IS NAMETEST

Initial Insured or Servicer Address ©lease Call Action & Center Master Policy Number B222225VGP
Fargo ND 58102-0000

Borrower and Property Information
Borrower Name Greenpath Test
Co-Borrower Name(s)
Property Address 75581 Lynn Dr

b Naperville IL 60540-0000 4

Mortgage Insurance Information
Commitment/Certificate Number 3808113081 Premium and Tax Information Rate Amount
Commitment Effective Date 07122022 First Year Premium 0.27000000%
Commitment Expiration Date 11/00/2022 First Premium 0.02250000% 58.50
Commitment Updated 07/12/2022 01:26:47 PM Surcharge 0.000% 0.00
Premium Payment Option Zero Monthly, Borrower Paid i
Term of Coverage 1 Month Coninty Tax o .
Plan LTV 85% Municipal Tax 0.000% 0.00
Coverage 25% Initial Total 0.00
Premium Refundability Non-Refundable First Month Total 56.50
Delegated/Non-Delegated Enact Underwritten

Premium Schedule:  For Months 1 -120: 0.2700% x Original Loan Amount x 1/12 Ranewal {ype Constant
(FM WI”‘YR&; -02250000%). 5 Renewal Rate (yrs 2 - 10) 0.27000000%
Months 121 - term: 0.2000% x Original Loan Amount x 1/1
(gigm Monthiy Rate = _mme;my,) * Renewal Rate (yrs 11 - term) 0.20000000%

Loan Information

Base Loan Amount 251,100.00 Sales Price 205,500.00 >
| = A o A nnn Valua ANE £0N8 OO 'Vl
The PDF commitment can also be viewed by Forms Tools  Services
clicking the icon on the Mortgage Insurance link » Order Credit Report B
under the Services tab or via the eFolder link on » Access Lenders
the loan toolbar. » Search Product and Pricing

» Request Underwriting
» Order Appraisal B
» Order Flood Certification

» Order Title & Closing

» Order Doc Preparation

» Register MERS

» Order AVM

» Order Mortgage Insurance

» Order Fraud/Audit Services

M1 eFolder I -

Enact mortgage insurers include Enact Mortgage Insurance Corporation

4
and Enact Mortgage Insurance Corporation of North Carolina. ®
© 2022 Enact Holdings, Inc. All rights reserved. n a c
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1) To import fees, select the Non- fract Reauest

Delegated MI order from the — =
order history list on the View tab. -I'-'naCt

Loan Information
2) Click the Import button ekt Borower L Loy
: Processor ID CoBomower: Lizard Lanisa
Loan Number: GNWPPM2213785
3) On the MI Fee Import popup, pr) Lm" e
. ve formation kem!d

click the Import Fees button. e
4) Once fees are imported, the Fees | oderte. Order Date Product Name Status

Successfully imported message | ®* TCHRUBEA T NonBelegedll Apared

appears, Click OK. B Mi Fee Import _ o x

Select the fees you want to import
Description Value H
[ Upfront MI Premium Rate 0
| Upload Documen| | EZ] M st Rate Duration 120
- ] [ Mi1st Rate 0270
Document Upload Hist | (4 ) 2nd Rate Duration 20
Date Docum ™M Mi2nd Rate 0.200 ime
7/6/2022 1003 - mitmentCertificate
7/6/2022  Apprais
7/6/2022  Credit Notice To User

Fees Imported X

0 Fees Successfully imported

Enact mortgage insurers include Enact Mortgage Insurance Corporation
and Enact Mortgage Insurance Corporation of North Carolina.

4
© 2022 Enact Holdings, Inc. All rights reserved. n a C
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The following data fields are updated as part of the fee import process. To locate a field in the list, use the
Encompass Go to Field functionality by pressing the CTRL + G to open the search box from within an
Encompass loan.

‘ Go to Field X
Fied ||
Cancel

Field Name FieldID | Field Name Field ID |
Initial Ml Payment 1766 MI Refundable Option CASASRN.X146
Initial Rate 1199 Renewal Type CASASRN.X148
Initial Rate Period 1198 Payment Option CASASRN.X152
Renewal Ml Payment 1710 Years of Coverage CASASRN.X156
Renewal Rate 1201 Renewal Option CASASRN.X150
Renewal Rate Period 1200 Payment Frequency CASASRN.X154
MI Coverage 430 Premium Source CASASRN.X158
Lender Paid Ml Checkbox 3533 PMI Coverage ULDD.FNM.430
Declining Renewal Checkbox 3248 MI Premium Source Type ULDD.X49
Prepaid Checkbox 2978 MI Company Name Type ULDD.X134
UFMIP 1107 Fannie Mae Ml Company Name Type Other ULDD.X136
Amount Paid in Cash Checkbox 1765 Freddie Mac Ml Company Name Type Other ULDD.X135
MI Company Name L248 File # VEND.X167
MI Company Address 708 Case # VEND.X177
MI Company City 709 MIC # CD1.X71
MI Company State 1252 MI Order Date 2308
MI Company ZIP 710 MI Received Date 2309

FOR MORE INFORMATION

Our ActionCenter® representatives are happy to help! 800-444-5664

Enact | 8325 Six Forks Road | Raleigh, NC 27615 | enactmi.com

For Encompass support, call 800-777-1718.

Enact mortgage insurers include Enact Mortgage Insurance Corporation

L ®
and Enact Mortgage Insurance Corporation of North Carolina. ®
© 2022 Enact Holdings, Inc. All rights reserved. n a C
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Enact’s integration with Encompass lets you order Ml without leaving your LOS. Use this guide to
determine which values to select from the Order tab (Fig. A), depending on the Enact MI Product you plan
to order.

INSTRUCTIONS Order || View
1) Locate the Enact Ml Product name you plan to order in P o o aoe -

the table below (Fig. B) Mortgage Insurance Information Mortgage Insurance Payment Option
2) Enter the associated data values as listed in the table for oot e r,; N > [T — .-

ields A-F. P Option | 220 Morthly v # [l Premium Rate Plan Type [ Level v »
3) Enter any additional data as needed in remaining fields. Bl reinaTre [ NotRendabi v| #Il 508 Preniom Pin Type v
4) We're here to help! Contact the ActionCenter® at 800- D o, 22 || i roed

444-5664 for additional support. Purchase Eigbity o —— .

Recommendation: M *
Enter these data field values (Fig. B
B D] E]

Premium MI Premium Premium Rate Split Premium
Payment Option Renewals Payment Plan Plan Type Plan Type*
Zero Not Refundable Constant or Borrower Paid
Monthly or Refundable Declining or Lender Paid e AN
Not Refundable Constant or Borrower Paid
LTI or Refundable Declining or Lender Paid e AR
Single Not Refundable - Borrower Paid
Premium or Refundable Declining or Lender Paid Level BLANK
Annual Refundable Congiuilar | FOusEr 2 Level BLANK
Declining or Lender Paid
; ; Split Premium 1-
Spl_lt Not Refundable Constant Borrower Pal_d Level 6
Premium or Refundable or Lender Paid
(See below)

* Availability of Split Premium product varies by state.
** LPMI Premiums are non-refundable.

* Split Premium MI

Plan1 Plan2 Plan3 Plan4 Plan5 Plan6 For more information about payment plans,
50% 75% 100% | 1.25% | 1.50% | 1.75% visit our website at enactmi.com. Rates may
not be available or approved for all states.

Enact mortgage insurers include Enact Mortgage Insurance Corporation

L
and Enact Mortgage Insurance Corporation of North Carolina. ®
© 2022 Enact Holdings, Inc. All rights reserved. n a C
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